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SI 5 Installation and Administration Guide 
 

The D-Tools System Integrator version 5 (SI5) Installation and Administration Guide was designed 

for Microsoft Visio 2003/2007, AutoCAD Version 2006/2007 and D-Tools SI5 system integration 

software. 

This document and its contents is the copyright of D-Tools, Inc. 2007. All rights reserved. 

Any redistribution or reproduction of part or all of the contents in any form is prohibited other than 

the following: 

 you may print or download to a local hard disk extracts for your personal and non-

commercial use only 

 you may copy the content to individual third parties for their personal use. 

You may not, except with our express written permission, distribute or commercially exploit the 

content. Nor may you transmit it or store it in any other website or other form of electronic 

retrieval system. 

Product and technology names mentioned in this material are the registered trademarks of their 

respected companies. 





 SI 5 Installation and Administration Guide v

Welcome to D-Tools SI5! 
Welcome to the growing family of D-Tools System Integrator (SI) users!  I want to thank you 

for putting your confidence in D-Tools software.  We know that D-Tools SI5 will be a powerful 

enhancement to your system integration business.  D-Tools SI is the leader in complete system 

integration software and has been proven by thousands of system integration companies that are 

already using it to more effectively design, engineer, document, estimate, sell, install, and manage 

their low voltage projects.  In fact, many companies have seen the software pay for itself in the 

first project through increased efficiencies throughout the company. 

This latest version of D-Tools SI has been extensively tested on various computer platforms, but it 

has not been tested on the most important one… yours.  Give it a try, run through a sample 

project, test it, and by all means, please don’t hesitate to contact us to report any issues or 

questions so we can continue to improve the software.  You will receive free in-version updates to 

our product over time as we continue to hone the product and add even more enhancements.  We 

want you to be successful with this product.  Feel free to contact us with ideas and thoughts about 

the program.  Some of our best enhancements have come from users just like you. 

While D-Tools has been designed to be simple to use, it is also a very deep and full functioned 

software product.  I have included some ideas you can use to make a smoother transition from 

your previous design, estimating and business management procedures to D-Tools SI: 

• Take a moment to peruse the users guide included with the software before jumping right 

in.  This guide is full of tips, tricks and detailed information that will help you get the most 

from the software. 

• Your corporate product database is one of your most important business assets.  Take the 

time to prepare your database by following the steps outlined in the Manage My Product 

Data (MMPD) interface.  MMPD was specifically designed to easily allow you to add, edit and 

enhance your product data.  In addition don’t forget to make frequent backups of your D-

Tools SI database and projects. 

• Open one of the sample projects included in your software.  See how we have created 

packages, accessories and miscellaneous labor costs.  Run all the reports you have available 

with this demo project.  Finally, take a small project that you have completed in the past, 

one that is successful and you are happy with.  This will allow you to get familiar with the 

program and begin to create a custom database of your most used products. 

I highly recommend product training.  Although not a requirement, product trainings are 

reasonably priced and are offered regionally throughout the year.  We offer a number of regional, 
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on-site or web based trainings.  Trainings are an excellent way to shorten the learning curve and 

quickly get up to speed.  For more information about trainings visit http://www.d-

tools.com/training.html.   

It is our hope to always keep product data current and free for you to use.  You can help in this 

regard by encouraging the manufacturers and reps you deal with to join the Manufacturer Vantage 

Point Partner Program.  Please have them e-mail mvp@d-tools.com for more information. 

Thank you again for your purchase.  If you take the time to implement the software into your 

everyday business practices, I know that you will join the growing group of companies using 

System Integrator who are seeing tremendous results!  Please contact me if I can be of any 

additional help.  

Sincerely, 

 

Adam Stone 

President 

adam@d-tools.com

mailto:mvp@d-tools.com
mailto:adam@d-tools.com
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D-Tools Contact Information 
Offices 

Western U.S. Office 
1850 Gateway Blvd – Suite 1060 
Concord, CA  94520 
Phone: 925.681.2326 
Fax: 925.681.2900 
Web: www.d-tools.com
 
Mid-Western U.S. Office 
2001 Crocker Road – Suite 220 
Westlake, OH  44145 
Phone: 925.681.2326 
Fax: 925.681.2900 
 
Eastern U.S. Office 
2839 Paces Ferry Road – Suite 370 
Atlanta, GA  30339 
Phone: 770.444.3101 
Fax: 770.444.3991 

Sales: 
Phone: 866.386.6571, Option 1 
Email: sales@d-tools.com

Training: 
Phone: 866.386.6571, Option 3 
Email: training@d-tools.com

Consulting: 
Phone: 866.386.6571, Option 1 
Email: consulting@d-tools.com

Administration 
Phone: 866.386.6571, Option 0 
Email: info@d-tools.com

Technical Support 
Phone: 866.386.6571, Option 2 
Email: support@d-tools.com
Web: www.d-tools.com/site/support/contact.html
Forum: www.d-tools.us

Manufacturer Vantage Point (MVP) Program: 
Phone: 866.386.6571, Option 5 
Email: mvp@d-tools.com

www.d-tools.com
mailto:sales@d-tools.com
mailto:training@d-tools.com
mailto:consulting@d-tools.com
mailto:info@d-tools.com
mailto:support@d-tools.com
http://www.d-tools.com/site/support/contact.html
www.d-tools.us
mailto:mvp@d-tools.com
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Software License Agreements 
End-User License Agreement for D-Tools System Integrator 5 

DO NOT INSTALL OR USE THE SOFTWARE UNTIL YOU HAVE READ AND ACCEPTED ALL OF THE 
LICENSE TERMS.  
Permission to use the software is conditional upon your agreement with these license terms (the "License").  Installation or use of the 
software by you will be deemed to be acceptance of the License and will create a legally enforceable contract with D-Tools, Inc.  IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL THE ACCOMPANYING SOFTWARE. IF YOU HAVE INSTALLED IT, 
PROMPTLY REMOVE ALL COPIES OF IT FROM YOUR COMPUTER. IF YOU PAID FOR THE RIGHT TO USE IT, RETURN IT IN ITS 
ORIGINAL CONDITION, WITH YOUR RECEIPT, TO THE POINT OF PURCHASE FOR A FULL REFUND. 
The installation of this program will install files necessary to operate the program onto your computer. Other system files, such as DLLs may 
be installed or updated and Windows registry entries will be made. Uninstalling the program will not remove all of the installed files or registry 
entries. As with all installations, it is recommended that you back up your hard drive before you install this program. 
  

Software License and Limited Warranty 

1. GRANT OF LICENSE. D-Tools, Inc., as Licensor, grants to you, the Licensee, a non-exclusive right to use a single copy of this software 
program in object code form (hereinafter the "SOFTWARE") in accordance with the terms contained in this License Agreement. You may 
not: 
a. Use the SOFTWARE on more than one computer or workstation at a time, or use it on a device functioning as a file server in a 

network or a multi-user system, or in any manner make it accessible to others, including via an electronic bulletin board, web site or 
other form of electronic distribution system;  

b. Modify, translate, reverse engineer, decompile, disassemble, create derivative works based on, or copy the SOFTWARE or the 
accompanying documentation, except to the extent, if any, that this limitation or any portion of it is expressly prohibited by 
applicable law and provided that you may make a single copy of the SOFTWARE for backup purposes only;  

c. Rent, lease or sublicense any rights in the SOFTWARE or accompanying documentation in any form to any person without the prior 
written consent of D-Tools, Inc., which, if given, is subject to the transferee's consent to the terms and conditions of this License;  

d. Remove any proprietary notices, labels, or marks on the SOFTWARE, documentation, and containers. 
 
2. OWNERSHIP OF SOFTWARE. D-Tools, Inc. retains the copyright, title and ownership of the SOFTWARE and the written materials 

regardless of the form or media in or on which the original and other copies may exist. 
 
3. TRANSFERS. You may transfer the SOFTWARE from one of your computers to another computer or person provided that the SOFTWARE 

is transferred without modification and, if the SOFTWARE is transferred to another person, that person agrees to be bound by the terms 
of this License, you obtain the written consent of D-Tools, Inc. prior to transferring the SOFTWARE, and you deliver to that person all 
existing copies of the SOFTWARE (or destroy any copies that are not delivered to that person), including the original and any installed or 
backup copies.  

 
4. TERM. The license granted under this License commences upon the installation of the SOFTWARE after acceptance of the terms of this 

License and is effective until terminated as provided herein. You may terminate this License at any time by destroying all copies of the 
SOFTWARE or by returning them to D-Tools, Inc.  D-Tools, Inc. may terminate this License if you fail to comply with any of the terms 
and conditions of this License Agreement.  Upon such termination, you agree to destroy or return the original and all copies of the 
SOFTWARE. 

 
5. US GOVERNMENT RIGHTS. The SOFTWARE is commercial computer software developed exclusively at private expense, and in all 

respects is proprietary data belonging to D-Tools, Inc. or its suppliers.  (a) Department of Defense End Users. If the SOFTWARE is 
acquired by or on behalf of agencies or units of the Department of Defense (DoD), then, pursuant to DoD FAR Supplement Section 
227.7202 and its successors (48 C.F.R. 227.7202) the Government's right to use, reproduce or disclose the SOFTWARE is subject to the 
restrictions of this Agreement.  (b) Civilian Agency End Users. If the SOFTWARE is acquired by or on behalf of Civilian agencies of the 
U.S. Government, then, pursuant to FAR Section 12.212 and its successors (47 C.F.R. 12.212), the Government's right to use, reproduce 
or disclose the SOFTWARE is subject to the restrictions of this Agreement. 

 
6. LIMITED WARRANTY.  D-Tools, Inc. warrants the media on which the SOFTWARE is furnished to be free of defects in material and 

workmanship, under normal use, for a period of ninety (90) days following the date of delivery to you. In the event of defects, D-Tools 
Inc.' sole liability shall be to replace the defective media which has been returned to D-Tools, Inc. or the supplier with your dated 
invoice, and is shown to be defective. In the event that D-Tools, Inc. is unable to replace defective media, D-Tools, Inc. shall refund your 
money upon your termination of this License.  THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
THAT IS MADE BY D-TOOLS, INC., ON THIS D-TOOLS, INC. PRODUCT.  NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY 
D-TOOLS, INC., ITS DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE 
SCOPE OF THIS WARRANTY AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. YOU MAY HAVE OTHER RIGHTS, 
WHICH VARY FROM STATE TO STATE. 
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7. THE SOFTWARE AND ACCOMPANYING DOCUMENTATION (INCLUDING INSTRUCTIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND EXCEPT FOR THE EXPRESS MEDIA WARRANTY IN SECTION 6 ABOVE.  FURTHER, D-TOOLS, INC. DOES NOT 
WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF THE SOFTWARE OR 
DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. YOU ASSUME THE ENTIRE 
RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE 
YOU, AND NOT D-TOOLS, INC. OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVISCNG, REPAIR OR CORRECTION.  YOU ACKNOWLEDGE THAT THE SOFTWARE IS INTENDED TO BE USED SOLELY 
FOR COMMERSCAL BUSINESS PURPOSES AND IS NOT A CONSUMER PRODUCT. 

 
8. NEITHER D-TOOLS, INC. NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THIS 

PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL OR INSCDENTAL DAMAGES (INCLUDING DAMAGES FOR 
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE 
USE OR INABILITY TO USE SUCH PRODUCT EVEN IF D-TOOLS, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

 
9. Should any other warranties be found to exist, such warranties shall be limited in duration to ninety (90) days following the date of 

delivery to you. In no event will D-Tools, Inc.' liability for any damages to you or any other person exceed the amount paid for the 
license to use the SOFTWARE. 

 
10. This License shall be governed and construed in accordance with the laws of the State of California and shall be binding on and inure to 

the benefit of D-Tools, Inc., its successors and assigns.  
 

Database License Agreement 

Use of the data in the D-Tools, Inc.  database is subject to the following terms and conditions: 
 
Rights in Data: D-Tools, Inc. is providing limited access to the data contained in this database (the "Data") under the licensed described 
below.  Except for the limited use rights granted through this license, all right, title and interest in the Data are and will continue to be the 
exclusive property of D-Tools, Inc. and its licensors. 
 
Registered Customers Only:  In order to use the Data, you must be an authorized licensee of a D-Tools, Inc. application and must have 
registered as a D-Tools, Inc. customer with the appropriate passwords for the "members only" section of the D-Tools, Inc. www site.  Such 
authorized customers are referred to as "Licensees." 
Limited License:  D-Tools, Inc. hereby grants Licensee a non-exclusive, non-transferable, limited license to access the Data solely for use with 
the D-Tools, Inc. applications and for no other purpose.  This license includes the right to download, install and store the Data ("Downloaded 
Data") using the D-Tools, Inc.  installer application provided for this purpose to a storage device under Licensee's exclusive control solely (i) to 
display internally such Downloaded Data and (ii) to quote and excerpt from such Downloaded Data by electronic cutting and pasting or other 
means in work product created by Licensee in the regular course of its work using the D-Tools, Inc. application. Licensee may also create 
printouts of Data for internal use and for distribution to third parties only for purposes of planning and implementing individual projects using 
the Data in connection with the planning, bidding, purchasing, constructing and billing processes. 
 
Limitations:  No person or entity who does not qualify as a Licensee under the above definition may access the Data or use the Data for any 
purpose.  With respect to Licensees: Except as expressly provided in this License Agreement, Licensee may not copy, download, store, 
publish, transmit, transfer, sell or otherwise use the Data, or any portion of the Data, in any form or by any means. Downloaded Data shall 
not be stored or used in an archival database or other searchable database except as part of the D-Tools, Inc.  application. Licensee shall not 
sell, license or distribute Data (including printouts and Downloaded Data) to third parties or use Data as a component of or as a basis for any 
material offered for sale, license or distribution. 

Notice to SI4 and SI3 upgrade users  

If you are upgrading from a previous version of System Integrator, the licenses for your previous versions will expire 180 days after you install 
SI5 and will not be available after that date. Contact D-Tools support for more information. 

End-User License Agreement for Microsoft Office Visio® 2007 

These license terms are an agreement between the licensor of the software application or suite of applications with which you acquired the 
Microsoft software (“Licensor”) and you.  Please read them.  They apply to the software that accompanies these license terms, which includes 
the media on which you received it, if any.  The terms also apply to any Microsoft updates, supplements, and Internet-based services for this 
software, unless other terms accompany those items.  If so, those terms apply. Microsoft Corporation or one of its affiliates (collectively, 
“Microsoft”) has licensed the software to Licensor. 

BY USING THE SOFTWARE, YOU ACCEPT THESE TERMS.  IF YOU DO NOT ACCEPT THEM, DO NOT USE THE SOFTWARE.  
INSTEAD, RETURN IT TO THE PLACE OF PURCHASE FOR A REFUND OR CREDIT.   

AS DESCRIBED BELOW, USING THE SOFTWARE ALSO OPERATES AS YOUR CONSENT TO THE TRANSMISSION OF CERTAIN 
COMPUTER INFORMATION DURING ACTIVATION, VALIDATION AND FOR INTERNET-BASED SERVICES. 

These terms supersede any electronic terms which may be contained within the software. If any of the terms contained within the software 
conflict with these terms, these terms will control.  

IF YOU COMPLY WITH THESE LICENSE TERMS, YOU HAVE THE RIGHTS BELOW FOR EACH LICENSE YOU ACQUIRE. 



 SI5 User and Administration Guide 11

OVERVIEW.  These license terms permit installation and use of one copy of the software on one device, along with other rights, all as 
described below. 

INSTALLATION AND USE RIGHTS.  Before you use the software under a license, you must assign that license to one device.  That device 
is the “licensed device.”  A hardware partition or blade is considered to be a separate device.   

Licensed Device.  You may install and use one copy of the software on the licensed device. 

Portable Device.  You may install another copy on a portable device for use by the single primary user of the licensed 
device. 

Separation of Components.  The components of the software are licensed as a single unit.  You may not separate the 
components and install them on different devices. 

ADDITIONAL LICENSING REQUIREMENTS AND/OR USE RIGHTS. 

Remote Access. The single primary user of the licensed device may access and use the software installed on the licensed device 
remotely from any other device.  You may allow other users to access the software to provide you with support services.  You do 
not need additional licenses for this access. No other person may use the software under the same license at the same time for any 
other purpose. 

Media Elements and Templates.  You may copy and use images, clip art, animations, sounds, music, shapes, video clips 
and templates provided with the software and identified for such use in documents and projects that you create.  You may 
distribute those documents and projects non-commercially.  If you wish to use these media elements or templates for any other 
purpose, go to www.microsoft.com/permission to learn whether that use is allowed. 

Font Components. While the software is running, you may use its fonts to display and print content. You may only embed 
fonts in content as permitted by the embedding restrictions in the fonts; and temporarily download them to a printer or other 
output device to help print content. 

Multiplexing.  Hardware or software you use to pool connections, or reduce the number of devices or users that directly 
access or use the software (sometimes referred to as “multiplexing” or “pooling”), does not reduce the number of licenses you 
need. 

Trial and Conversion.  Some or all of the software may be licensed on a trial basis.  Your rights to use trial software are limited to the 
trial period.  The trial software and length of the trial period are set forth during the activation process.  You may have the option to 
convert your trial rights to subscription or perpetual rights.  Conversion options will be presented to you at the expiration of your 
trial period.  After the expiration of any trial period without conversion, most features of the trial software will stop running.  At that 
time you can continue to open, view and print any documents you created with the trial software. 

Subscription Software.  If you licensed the software on a subscription basis, your rights to use the software are limited to the 
subscription period.  You may have the option to extend your subscription or convert to a perpetual license.  If you extend your 
subscription, you may continue using the software until the end of your extended subscription period.  See the software activation 
screens or other accompanying materials for subscription details.  After the expiration of your subscription, most features of the 
software will stop running.  At that time you can continue to open, view and print any documents you created with the software. 

Pre-Activation. If you acquired an edition other than Microsoft Office Ultimate 2007, some functionality is licensed for your use only 
until you activate the software or the end of the time recommended for activation, whichever comes first.   

Home Use Rights Edition.  If you licensed a Home Use Rights edition, the licensed device must be used primarily within your home. 

Development Tools.  The software may contain Microsoft Visual Studio Tools for Applications or other development tools.  You may 
use any development tools included in the software only to design, develop, test, use and demonstrate your programs with the 
software. 

MANDATORY ACTIVATION.  Activation associates the use of the software with a specific device. During activation, the software will send 
information about the software and the device to Microsoft. This information includes the version, the license version, language and the 
product ID of the software, Internet protocol address of the device and information derived from the hardware configuration.  For more 
information, see www.microsoft.com/piracy/activation.mspx.   BY USING THE SOFTWARE, YOU CONSENT TO THE TRANSMISSION OF 
THIS INFORMATION.  After the time recommended for activation expires, your rights to use the software will be limited until the 
software is activated.  This is to prevent its unlicensed use.  You can activate the software by Internet or telephone; Internet and 
telephone service charges may apply.  Some changes to your computer components or the software may require you to reactivate the 
software.  THE SOFTWARE WILL REMIND YOU TO ACTIVATE UNTIL YOU DO. 

VALIDATION. 

The software will from time to time update or require download of the validation feature of the software.  Validation verifies that the 
software has been activated and is properly licensed.  Validation also permits you to use certain features of the software or to 
obtain additional benefits. For more information, see www.microsoft.com/genuine/office/WhyValidate.aspx. 

During a validation check, the software will send information about the software to Microsoft. This information includes the version of the 
software and the product key.  Microsoft does not use the information to identify or contact you.  BY USING THE SOFTWARE, YOU 
CONSENT TO THE TRANSMISSION OF THIS INFORMATION.  For more information, see 
www.microsoft.com/genuine/office/PrivacyInfo.aspx. 

If the software is not properly licensed, the functionality of the software may be affected.  For example, you may need to reactivate the 
software, or receive reminders to obtain a properly licensed copy of the software, or not obtain certain updates, upgrades or 
services from Microsoft. 

http://www.microsoft.com/permission
http://www.microsoft.com/piracy/activation.mspx
http://www.microsoft.com/genuine/office/WhyValidate.aspx
http://www.microsoft.com/genuine/office/PrivacyInfo.aspx
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You may only obtain updates or upgrades for the software from Microsoft or authorized sources.  For more information on obtaining 
updates from authorized sources, see www.microsoft.com/genuine/downloads/faq.aspx. 

INTERNET-BASED SERVICES.  Microsoft provides Internet-based services with the software.  Except as otherwise noted in materials 
accompanying a service, it may change or cancel them at any time. 

Consent for Internet-Based Services.  The software features described below connect to Microsoft or service provider computer 
systems over the Internet.  In some cases, you will not receive a separate notice when they connect.  Unless otherwise noted, you 
may switch off these features or not use them.  For more information about these features, see www.office.microsoft.com/en-
us/FX010986541033.aspx.  BY USING THESE FEATURES, YOU CONSENT TO THE TRANSMISSION OF THIS INFORMATION.  
Microsoft does not use the information to identify or contact you. 

Computer Information.  The following features use Internet protocols, which send to the appropriate systems computer information, 
such as your Internet protocol address, the type of operating system, browser and name and version of the software you are using, 
and the language code of the device where you installed the software.  Microsoft uses this information to make the Internet-based 
services available to you. 

Web Content Features.  Features in the software can retrieve related content from Microsoft and provide it to you.  Examples of 
these features are clip art, templates, online training, online assistance and Appshelp.  You may choose not to use these web 
content features. 

Digital Certificates.  The software uses digital certificates.  These digital certificates confirm the identity of Internet users sending 
X.509 standard encrypted information.  They also can be used to digitally sign files and macros to verify the integrity and origin of 
the file contents.  The software retrieves certificates and updates certificate revocation lists using the Internet, when available. 

Information Rights Management.  The software contains a feature that allows you to create content that cannot be printed, copied 
or sent to others without your permission. You may need to connect to Microsoft to use this feature for the first time. Once a year, 
you may need to re-connect to Microsoft to update it. For more information, go to www.office.microsoft.com/en-
us/assistance/HA010397891033.aspx.  You may choose not to use this feature. 

Misuse of Internet-based Services.  You may not use these services in any way that could harm them or impair anyone else’s use of 
them.  You may not use the services to try to gain unauthorized access to any service, data, account or network by any means. 

SCOPE OF LICENSE.  The software is licensed, not sold. This agreement only gives you some rights to use the software.  Licensor and 
Microsoft reserve all other rights.  Unless applicable law gives you more rights despite this limitation, you may use the software only as 
expressly permitted in this agreement.  In doing so, you must comply with any technical limitations in the software that only allow you to 
use it in certain ways.  For more information, see www.microsoft.com/licensing/userights.  You may not: 

work around any technical limitations in the software; 

reverse engineer, decompile or disassemble the software, except and only to the extent that applicable law expressly permits, despite 
this limitation; 

make more copies of the software than specified in this agreement or allowed by applicable law, despite this limitation; 

publish the software for others to copy; 

use the software in any way that is against the law; 

rent, lease or lend the software; or 

use the software for commercial software hosting services. 

BACKUP COPY.  You may make one backup copy of the media.  You may use it only to reinstall the software. 

DOCUMENTATION.  Any person that has valid access to your computer or internal network may copy and use the documentation for your 
internal, reference purposes. 

NOT FOR RESALE SOFTWARE.  You may not sell software marked as “NFR” or “Not for Resale.” 

ACADEMIC EDITION SOFTWARE.  You must be a “Qualified Educational User” to use software marked as “Academic Edition” or “AE.”   If 
you do not know whether you are a Qualified Educational User, visit www.microsoft.com/education or contact the Microsoft affiliate 
serving your country. 

HOME USE RIGHTS SOFTWARE.  You must be a “Home Use Rights User” to use software marked as “Home Use Rights Edition.”  To be a 
Home Use Rights User, you must be both: 

an employee of an organization that has a Microsoft Volume License agreement with Software Assurance, and 

the user of a licensed copy of the software, or a product that includes the software, with active Software Assurance.   

UPGRADE OR CONVERSION.  To upgrade or convert software, you must first be licensed for the software that is eligible for the upgrade or 
conversion.  Upon upgrade or conversion, this agreement takes the place of the agreement for the software you upgraded or converted 
from.  After you upgrade or convert, you may no longer use the earlier version of the software you upgraded or converted from. 

REASSIGN TO ANOTHER DEVICE.  You may reassign the license to a different device any number of times, but not more than one time 
every 90 days.  If you reassign, that other device becomes the “licensed device.”  If you retire the licensed device due to hardware 
failure, you may reassign the license sooner. 

http://www.microsoft.com/genuine/downloads/faq.aspx
http://www.office.microsoft.com/en-us/FX010986541033.aspx
http://www.office.microsoft.com/en-us/FX010986541033.aspx
http://www.office.microsoft.com/en-us/assistance/HA010397891033.aspx
http://www.office.microsoft.com/en-us/assistance/HA010397891033.aspx
http://www.microsoft.com/licensing/userights
http://www.microsoft.com/education
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TRANSFER TO A THIRD PARTY.  The first user of the software may make a one-time transfer of the software, and this agreement, directly 
to another end user as part of a transfer of the integrated software turnkey application or suite of applications (the “Unified Solution”) 
delivered to you by or on behalf of the Licensor solely as part of the Unified Solution.  The first user must uninstall the software before 
transferring it separately from the device.  The first user may not retain any copies. Before any permitted transfer, the end user must 
agree that this agreement applies to the transfer and use of the software. 

EXPORT RESTRICTIONS.  The software is subject to United States export laws and regulations.  You must comply with all domestic and 
international export laws and regulations that apply to the software.  These laws include restrictions on destinations, end users and end 
use.  For additional information, see www.microsoft.com/exporting. 

ENTIRE AGREEMENT.  This agreement, any addendum or amendment included with the software, and the terms for supplements, updates 
and Internet-based services that you use, are the entire agreement for the software. 

LEGAL EFFECT.  This agreement describes certain legal rights.  You may have other rights under the laws of your state or country.  You may 
also have rights with respect to the Licensor from whom you acquired the software.  This agreement does not change your rights under 
the laws of your state or country if the laws of your state or country do not permit it to do so. 

NOT FAULT TOLERANT.  THE SOFTWARE IS NOT FAULT TOLERANT.  LICENSOR HAS INDEPENDENTLY DETERMINED HOW TO 
USE THE SOFTWARE IN THE INTEGRATED SOFTWARE APPLICATION OR SUITE OF APPLICATIONS THAT IT IS 
LICENSING TO YOU, AND MICROSOFT HAS RELIED ON LICENSOR TO CONDUCT SUFFICIENT TESTING TO DETERMINE 
THAT THE SOFTWARE IS SUITABLE FOR SUCH USE. 

NO WARRANTIES BY MICROSOFT.  YOU AGREE THAT IF YOU HAVE RECEIVED ANY WARRANTIES WITH REGARD TO EITHER 
(A) THE SOFTWARE, OR (B) THE SOFTWARE APPLICATION OR SUITE OF APPLICATIONS WITH WHICH YOU ACQUIRED 
THE SOFTWARE, THEN THOSE WARRANTIES ARE PROVIDED SOLELY BY THE LICENSOR AND DO NOT ORIGINATE FROM, 
AND ARE NOT BINDING ON, MICROSOFT. 

NO LIABILITY OF MICROSOFT FOR CERTAIN DAMAGES.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
MICROSOFT SHALL HAVE NO LIABILITY FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES 
ARISING FROM OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THE SOFTWARE OR THE SOFTWARE 
APPLICATION OR SUITE OF APPLICATIONS WITH WHICH YOU ACQUIRED THE SOFTWARE, INCLUDING WITHOUT 
LIMITATION, PENALTIES IMPOSED BY GOVERNMENT.  THIS LIMITATION WILL APPLY EVEN IF ANY REMEDY FAILS OF 
ITS ESSENTIAL PURPOSE.  IN NO EVENT SHALL MICROSOFT BE LIABLE FOR ANY AMOUNT IN EXCESS OF TWO HUNDRED 
FIFTY U.S. DOLLARS (US$250.00). 

Microsoft is a registered trademark of Microsoft Corporation in the United States and/or other countries. 

 

http://www.microsoft.com/exporting
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Documentation Updates 
Our documentation is under continuous improvement.  To make sure you have the most recent versions please 

download the following. 

Installation and Administration Guide 
http://www.d-tools.com/site/downloads/SI%205%20Installation%20and%20Administration%20Guide.pdf

User Guide 
http://www.d-tools.com/site/downloads/SI%205%20User%20Guide.pdf

Tutorial 
http://www.d-tools.com/site/downloads/SI%205%20Tutorial.pdf

Forum 

The D-Tools form provides a wealth of additional information about SI 5.  We strongly encourage 

you to join the community and take advantage of the wealth of information provided.  The forums 

are reviewed daily by D-Tools staff, partners and experiences users.  You will find answers to most 

of your questions by using the forum search feature.  Sign up today at 

http://www.d-tools.us

http://www.d-tools.com/site/downloads/SI%205%20Installation%20and%20Administration%20Guide.pdf
http://www.d-tools.com/site/downloads/SI%205%20User%20Guide.pdf
http://www.d-tools.com/site/downloads/SI%205%20Tutorial.pdf
http://www.d-tools.us/
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System Requirements 
Hardware requirements 

2 GHz Pentium 4 (3 GHz recommended)  

512 MB RAM (1 GB is recommended)  

1GB Hard Drive (80GB is recommended)  

XGA (1024x768) or better display device (Dual Displays recommended) 

OS Requirements 
Windows XP Service Pack 2 or higher 

Service Pack 2 can be downloaded from: http://www.microsoft.com/windowsxp/sp2/default.mspx

Windows Vista Current Release 

Windows Required Components 
.Net2.0* Included on CD 

.Net3.0* Included on CD 

WSE3.0* Included on CD 

Windows Installer 3.1** (Use Control Panel > Add or Remove Programs to verify) 

  Click here to download

 

http://www.microsoft.com/windowsxp/sp2/default.mspx
http://www.microsoft.com/downloads/details.aspx?FamilyId=889482FC-5F56-4A38-B838-DE776FD4138C&displaylang=en
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Compatibility 
SI 5 is compatible with the following third party applications: 

XP  

Visio 2003 & 2007 

Microsoft Office 2003 & 2007 

AutoCAD 2006-2008 

QuickBooks: http://www.d-tools.com/site/products/link_tools_quickbooks.html

Vista  

Visio 2003 & 2007 

Microsoft Office 2003 & 2007 

AutoCAD 2007* & 2008 

QuickBooks: http://www.d-tools.com/site/products/link_tools_quickbooks.html

*AutoCAD 2007 on Vista requires the latest patches from the Autodesk website (click here). 

 

If applicable, please install the third party drawing software you plan to use prior to installing SI 5.  

If you purchased SI 5 Standard or Professional, a license to Visio 2007 is included.  You will find 

the installer located inside the Visio2007 folder on the SI 5 CD, or CD image. 

http://www.d-tools.com/site/products/link_tools_quickbooks.html
http://www.d-tools.com/site/products/link_tools_quickbooks.html
http://usa.autodesk.com/adsk/servlet/ps/dl/item?siteID=123112&id=9444984&linkID=9240618
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SI 5 License Guide 
Let’s start by defining our terms and then we will take a look at the different kinds of licenses and 

how they are managed. 

Definitions 
Customer:  Any organization which has purchased seat(s) of SI 5. 

User:  Any member of a customer assigned to use a seat of SI 5.  There are two types of users, a) 

Machine and b) Network.  See “License Type” below. 

Seat:  An install of SI 5. While a customer may have many seats, a particular seat’s functionality is 

determined by the assignment of a license. 

License:  Represents a single sold unit of SI 5.  A license must be sold for any seat to be 

activated.  Users are assigned to licenses and the functionality of their seat is controlled by: 

• The existence of a license. 

• The type of license that is activated (Machine) or assigned to the user (Network). 

License Type:  There are two types of desktop licenses: 

Machine:  These are standalone licenses that are NOT managed by the LANSync Admin 

Console.  When installing you will need the CD Key associated with the particular license.  

These licenses cannot synchronize data with other users or use Business Manager 

functionality.  It is possible to install a Machine user within an organization that uses 

LANSync, see “Installing Desktop Components”. 

Network (LANSync):  A Network license installs all of the SI 5 functionality on the Seat.  

However, the functionality presented to the user will depend on the license assigned to that 

user via the LANSync Admin Console.  For example a Text user and a Pro user could share 

the same machine. You may install Network licenses on as many computers as you like, 

however, only one user may use the license at a time.  

Pro (Professional) License:  When purchased, this license includes a license for both LANSync 

and Business Manager.  However when assigning users to licenses, the Business Manager license 

associated with the Pro license may instead be attached as an Add-On license to a Standard or 

Text license. 
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Standard: All Pro functionality except for a) MS Office integration b) access to the Report 

Designer, c) LANSync functionality and d) Business Manager functionality.  As long as you 

purchased at least one Pro License, Standard may operate in a Server environment.  A Business 

Manager Add-On license may be associated with a Standard license via the LANSync Admin 

Console. 

Text:  Same as Standard but without drawing capability.  

LanSync: “Server” module allowing for the product sharing, project sharing, and license 

management. It is also required for the correct and complete operation of Business Manager. 

Only one license of LANSync need be present for all licensed seats to use the functionality.   

BusinessManager(BM): Provides reporting, Sales Order and Work Order functionality.  Business 

Manager is considered an Add-On license.  

Add-On:  Licensed functionality added to a seat of SI 5. Add-Ons are sold as separate licenses or 

bundled with existing licenses, such as Pro.  Add-On licenses are dependent on an existing licensed 

seat or user in order to function.   

LinkTools:  Add-on functionality for managing Accounting System integrations.  

Status: There are four license statuses: 

• Active:  Means the license is valid for all uses. 

• Deactive:  Means the license is invalid for any further use. 

• Deactivate On:  Includes a date. License is valid so long as the expiration date is in the 

future.  

• Trial:  Trial licenses are equivalent to Deactivate On status. The license is useable until the 

expiration date is met.  

License Requirements 
The following rules apply to all Registration functionality  

• A Customer must create an Administration user to access the LANSync Admin Console. 

• The administration user is not a user of SI5 and does not need to be associated to a SI5 

license. The administration user is simply a login to the administration console. 

• During an install or upgrade, the Administration user must be created. 
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• A customer may have more users than licenses. 

• More than one user may be assigned to the same license.  However, only one user at a time 

may use that license. 

• A customer may install more seats than licenses.  In a Network installation, you may use 

the same CD key for all Desktop installs. 

• A user must be assigned to a license in order to use a seat of SI-5. 

• If a user is using a license, their license cannot be reassigned.  

• Logging off of SI “frees up” a license so it could be reassigned or used by another assigned 

user. 

• A user can only be assigned to one license of type Pro, Standard or Text. 

• Users do not need to be assigned Business Manager licenses in order to share projects.  All 

project and data sharing is a function of the availability of a Network install and appropriate 

user permissions. 

• A user can be assigned to one Add-On license of each type. 

• Users do not have to be assigned LANSync licenses in a Network install.  LANSync enabled 

functionality only requires a successful connection to the LANSync server. 

• At least one LANSync license must be present to make project and data sharing 

functionality available to all users. 

• Users must have a Business Manager license in order to access Business Manager reporting, 

Sales Order and Work Order functionality. 

• Sales and Work Order functionality require an active connection to the LANSync server. 

Most features of the Revision Manager, however, do not.  

• A user in a company using Software Assurance must validate their license at least once 

every 30 days.  

• An active internet connection is required to initially register the software, and to validate the 

license every 30 days (Software Assurance customers only). 

Within a Network install, users are either logged in or logged out. When a user closes SI 5 they are 

automatically logged off unless they choose to work offline. 
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License Validation and Expiration 
License expiration dates are advanced 30 days every time the Machine user logs in, if the 

registration system designates the customer as having a valid license.  If the user cannot connect 

to our server, then the expiration date is not advanced.  Advancing the expiration date continues to 

require that our users connect to us at least once every 30 days. They DO NOT, however, have to 

actively perform that task.  Every time a user opens SI and an internet connection is present, we 

will validate the license. If the license is valid, the expiration date will advance 30 days. Expiration 

dates are updated to LANSync on each log in. The system will prompt the user five days prior to 

expiration. An active internet connection is all that is required. 

If a license is checked out and the user experiences a hardware failure or their computer is stolen, 

contact D-Tools Support for instructions on how to “release” this license, so that it may once again 

be used within your organization. 

License Management 
Machine Users:  Install SI 5 using the CD key associated with the desired functionality. 

Network Server:  Install the LANSync Server using a LANSync license CD key. 

Network User:  Use any non-LANSync CD key to install the Desktop Components.  User license 

assignment will be managed by the LANSync Admin Console.  See “SI 5 Administration” later in 

this guide. 
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Installation Overview 
The flowchart on the following page describes the installation process for the majority of users.  

These installation scenarios include: 

1) New Users:  These are users that are installing D-Tools products for the first time.  New users 

would fall into two categories: 

a) LANSync Users:  These are users that have purchased at least one license of SI 5 

Pro and wish to use Business Manager and/or share data and projects between 

multiple users. 

b) Standalone Users:  These are users that have purchased a single license of SI 5 

and intend to run it on only one computer. 

2) Current SI 4.6 User:  These are current SI 4.6 users that have purchased SI 5.  Keep in mind 

that SI 5 is a new standalone application, it is NOT and “upgrade”.  Therefore SI 4.6 and SI 5 

can run on the same computer at the same time.  This will allow you to continue to work on 

existing projects in SI 4.6 while you are preparing for the transition to SI 5.  It is NOT 

necessary or recommended that you uninstall SI 4.6.  The key issues for existing SI 4.6 users 

are: 

a) Database Conversion: During the Server Install you will be given an opportunity 

to copy your existing SI 4.6 database and setup information to SI 5.  To assure 

that all database updates are included, we recommend that each SI 4.6 user on 

your network run LANSync prior to installing the SI 5 server components and 

copying the database. 

b) Importing Projects:  Once the install is complete, you will use the SI 5 Project 

Navigator to import and “Check-In” projects.   

Note:  All server data and shared Projects are now managed by LANSync.  In SI 4.6 

this functionality was associated with Business Manager.   

3) SI 5 Beta User:  First we would like to say THANKS to all our SI 5 Beta participants.  Your 

feedback was and will continue to be valued by our team.  It is not required, but we 

recommend that you remove the SI 5 Beta before installing the current version of SI 5.  Your 

primary decision will be to either: 

a) Use the database you have been working with during the Beta process or 
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b) Convert your existing SI 4.6 data during the Server Installation process. 

4) If you are using a D-Tools product prior to SI 4.6, contact D-Tools support for instructions on 

how to proceed. 
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Installing SI 5 
The installation process consists of the following basic elements.  See the flowchart on the previous 

page to determine your particular installation process: 

1) Install Installation Utility – This utility will manage the installation of all SI 5 applications 

and components. 

2) Install Server Components – These must be physically installed on the Server computer.  

They cannot be installed over the LAN. 

a) LANSync – Manages shared data, projects, licenses, permissions and users 

b) Project Share – Location of Projects Share 

c) Project Data Share – SQL data associated with all aspects of the project 

d) Administration Console – Manages Users, Groups, Licenses and Permissions 

e) SQL Server Components (if you choose) 

3) Install Desktop (Client) Components – These will be installed on the individual User 

a) SI 5 Pro 

b) SI 5 Standard 

c) SI 5 Text 
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System Integrator 5 Install Utility Setup Wizard 
1) Insert disc into CD-ROM or better drive.  Yes, we have to put this as a step... 

2) If the installation process does not automatically begin, browse to the CD drive and Double-

click the Setup.exe file.  The System Integrator 5 Install Utility Setup form will open.  Click 

[Next >]. 

 

3) Read and accept the Software License Agreement and click [Next >]. 

 

4) Choose the folder where you would like to install SI 5 and click [Next >]. We highly 

recommend that you leave the folder set to C:\Program Files\D-Tools\SI 5. 
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5) When you are sure you want to install, click [Install].  
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Installation progress displays: 

 

6) Click [Finish] when prompted: 
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The System Integrator 5 Install Utility has been added to your list of programs: 

 

 

If you leave the “Launch System Integrator 5 Install Utility” box checked, the SI 5 

Installation Wizard will launch.  It can also be launched from Start > All Programs > 

D-Tools > Install Utility. 

 

System Integrator 5 Installation Wizard 
This wizard will walk you through the installation of SI 5.  It is launched automatically during the 

installation process or it can be launched manually by: Start->All Programs->D-Tools->Install 
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Utility.  There are two main types of installs for SI 5: Server Components and Desktop 

Components. 
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Installing Server Components 
The Server Components should be installed on the machine that you are treating as your server.  

This machine could be a dedicated server (recommended) or it could be user’s desktop PC.  The 

installation must take place on the target machine, it cannot be installed over the LAN. 
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1) Clicking [Install] in the Server Components section begins the process for installing the 

LANSync Server: 

 

2) Click [Start]. You will then be prompted to enter your SI 5 LANSync License Key: 
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3) Enter your LANSync CD-Key and click [Next].  You will be prompted to select your Project and 

Product share folders.  Click [Next]. 

 

The Project Share Folder is where you your server based projects will be stored.  

Each project will reside in a subfolder (or two or three) within the root of the folder 

chosen above.  

The Request Port is set to 9000 by default.  If you have a firewall installed you must 

either open port 9000 or change this value to an available open port.  If you do not 

know what ports are available, contact your IT personnel or whoever configured your 

firewall. 
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4) The next step is set your database configuration.  We recommend that use the SQL Server 

2005 Install rather than an existing SQL server database.  If you wish to use an existing SQL 

server database, you should contact your IT professional or database administrator for proper 

login credentials.  When ready, click [Next]. 

 

If this is not the first time you have installed the Server Components on this machine 

you will see the following prompt, choose wisely. 
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5) If you are an SI 4 user, you will have the option of migrating your SI 4 product data.  If you do 

not wish to use your SI 4 Product Data, i.e. you want to start fresh, or if you are installing D-

Tools SI for the first time, click [Next].   

 

6) If you wish to migrate your data, check the “Yes, migrate my 4.x Product and User Data” box. 
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7) You are then prompted to create a User Name and Password for the Administration Console 

within the LANSync server.  Password is case sensitive.  When finished, click [Next].   

 

8) When ready to complete the installation, click [Install LanSync] 
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9) Files will extract and install: 

 

10) You should see a screen similar to the following that will temporarily appear during the 

installation process. 

 

11) Microsoft SQL Server 2005 Express will install: 
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12) You will be prompted to login with the credentials provided in Step 7 above. 

 

Here is a recap of what was just installed on your LANSync Server machine: 

What Type Path Purpose 
SI 5 Product 
Database 

SQL SQL Server Stores all SI 5 Product data 

SI 5 User 
Database 

SQL SQL Server Stores the Groups and User 
Permissions 

Product Share 
Folder 

Folder C:\Dtools\SI5\Server\Products Stores common data to be 
distributed via LANSync to the All 
Users Directory 

Project Share 
Folder 

Folder C:\Dtools\SI5\Server\Projects Stores SI 5 Project files 

The following entry has been added to your Add/Remove programs: 
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At this point, you can click [Cancel] to install the SI 5 Desktop software on this machine or you 

may choose to click [Open Admin Console] to manage your users and licenses.  See SI 5 

Administration for details. 
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SI 5 Administration 
The SI 5 Administration Console is where you will manage Users, Groups, Licenses and Server 

Data. 

 

 

1) When you launch the SI 5 Administration console you will be prompted to login.  Only an 

Administrative user will be allowed to login. 
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2) Licenses will update: 

 

3) The Start Page displays: 

 

To get back to the Start Page at any time, select  … 
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Users 
Users are managed with the User’s dropdown on the Start page. 

 

Add New User 

Select “Add New User” and the following form is presented.  Email field is required.  Don’t be 

concerned about Group assignment.  You will assign the Users to appropriate Groups in the 

“Manage Groups” section later in this chapter. 
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Manage Users 

1) Click the triangle next to Users and select Manager Users. 

2) The following form will appear: 

 

3) Use the [Edit] and [Remove] buttons to manage existing Users or use [New] to create a new 

User. When you click [New], the Add/Edit User form opens: 

 

4) Fill in all fields and then click [Save].  Role is for your reference only.  It is not used elsewhere 

in SI 5.  Don’t be concerned about Group assignment at this time.  You will create Groups and 

assign users to those groups in the next step. 
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Groups 
Create Groups to more efficiently manage user rights.  Typical Groups could include Sales, 

Engineering, Accounting, and Installation.   

Manage Groups 

To manage your Groups, click Manage Groups on the Start Page. 

 

The following screen displays: 

 

SI 5 comes pre-set with two Groups: Administrators and Everyone.  To modify the 

permissions for any Group, select the Group from the “View” dropdown and select 

“Permissions” from the Edit dropdown.  Use the [>>] and [<<] buttons to modify 

the existing permissions.  To assign Users to a Group, select the Group from the 

“View” dropdown and select “Users” from the Edit dropdown.  Use the [>>] and 
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[<<] buttons to add/remove Users.  Click [Save] to save changes to a Group, 

[Remove] to delete a Group. 

 

To create a new Group, click [New].  You will be prompted to enter a Group Name: 
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Click [Next>] and you will be prompted to add Users to the Group: 

 

Add Users with the [>>] and [<<] buttons and then click [Next>].  You will then be prompted to 

add Group Permissions: 

 

Care should be taken when assigning permissions.  Most permissions Grant Rights.   

However, a few cost and accounting permissions Restrict Rights.   
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Permission Behavior 

Projects Page Grants access to the Projects tab of the Navigator 

Create Project Grants access to create a Project 

Edit All Projects Grants access to edit ANY Project 

Edit Own Projects Grants access to only those Projects created by the user 

Read All Projects Grants access to read/view Projects 

Read Own Projects Grants access to read/view only those Projects created by the 

user 

Delete Project Grants right to delete Projects 

Project Administration Page Grants access to Project Set-up Page in Navigator 

Data Page Grants access to MMPD 

Add/Edit Data Allows user to add and edit data to the database.  This could 

occur via MMPD or during project creation 

Delete Data Allows user to delete data from the Database 

LANSync Data Sync Allows modifications to the local database to update the 

shared master database 

LANSync Administrator Allows user access to the LANSync administration page.  The 

user will still need to know the administrator password. 

Edit Client Allows user to edit clients in the client table 

Delete Client Allows user to delete a client from the client table 

Data Administration Page Allows user to Compact master database, Backup master 

database or Restore master database.  

Business Manager Admin Page Allows user to administer Business Manager 

Business Manager Page Allows user access to Business Manager functionality 

Create Custom Reports Allows user to generate and install custom reports 
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Permission Behavior 

Run Excel Reports Allows user to run Excel reports. 

Restrict Cost Factors Restricts user from modifying global cost and price factors  

(see Navigator > Setup > Price in the SI 5 User Guide) 

Restrict Price Restricts user from modifying the price of a Product in the 

database 

Restrict Cost Restricts user from modifying the cost of a Product in the 

database 

Restrict Accounting Information Restricts user from modifying Tax Codes and Rates 

Once you’ve added the Group Permissions, click [Save]. 

Licenses  
To manage licenses select the dropdown as show below. 
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Assign Licenses 

When you select Assign Licenses the following form is displayed. 

 

Select the appropriate row.  The row will turn dark gray.  Once selected, choose one of the 

following commands.: 

.. Provides details about the selected license, including assigned users 
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This allows you to add additional functionality to your main license, in this case SI 5 

Professional.  You can “Add-On” a license to SI 5 Text, SI 5 Standard or SI 5 

Professional.  Add-On licenses include Business Manager and LinkTools. 

 

“Learn About” links are found throughout the Administration Console interface.  

Consider these links as mini-FAQs.  They will answer many of the questions you may 

have about the interface. 

......Allows the administrator to release a license that cannot be checked in.  A “Release” 

may be required if the computer is lost, stolen or becomes unusable while SI 5 is 

checked out.  If this is the case you will need to contact D-Tools for a release code.  

The release code provided by support will be entered in the form below. 
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  This is where you assign licenses to Users.   

1) Select the license to be assigned from the following form.  In this example we selected SI5 

Text. 

 

2) Then click “Assign Users” and the following form will appear.  Select the user(s) to grant access 

to this license.  Yes, you may assign multiple users to a single license, but ONLY one user at a 

time may have the license Checked Out (in use).  When finished click [Save]. 

 

You will notice that “Current User” does not change.  Current User tracks Checked 

Out licenses, not assigned licenses. 
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Select Licenses > Assign Licenses to see which SI 5 licenses are Checked Out throughout your 

organization.  

 

Just because a license is shown as a “Child” license does not mean that is must be 

assigned to the same User as the Parent.  You may wish to do this to keep your 

sanity, but it is not required. 

Check For Updates 

If you have recently purchased additional licenses or for some other reason need to refresh your 

list of licenses click Licenses > Check For Updates from the Start Page.   
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The following activity bar will appear: 

 

Once complete the Grid should refresh.  If not, click [Refresh Grid]. 

Manage 
The Manage tab provides some additional tools for Server data and Administration User 

management.   

 

Database (Server) 

Clicking Manage > Database will provide the following interface for: 

a) Backup SI 5 Server Product Database 

b) Restore SI 5 Server Database from Backup 

c) Backup SI 5 Projects Database 

d) Restore SI 5 Projects Database from Backup 
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You should make a habit of creating daily backups of your Product and Projects data.  Be sure to 

backup this data to a different physical device.  If you are using a dedicated server, it may include 

software that will automatically backup SQL data.   

Backup of Local Project and Local Product data is managed by MMPD.  See Backups and Restoring 

in the SI 5 User Guide. 
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Administration Users 

Open the following form by selecting Manage > Administration Users from the Start Page.  This 

is where you can Add, Delete and Edit users that can have access to the SI Administration Console.   

 

 

 



 SI5 User and Administration Guide 61

Installing Desktop Components 
We recommend that you assign users to licenses before installing Desktop Components  

1) Clicking “Install” in the Desktop Components section begins the process for installing the SI 5 

application on your machine: 

 

2) If you purchased SI 5 Pro or Standard, Visio is included on the CD and should be installed 

before proceeding.  See “Compatibility” for more details. 
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3) You will first be prompted to enter your CD-Key: 

 

4) Enter your CD-Key and click [Next]. You may use any Desktop License CD key you like from 

the packing slip.  You may also use the same key on every machine.  You will be prompted to 

verify your license information: 

 

If you have a lot of users, a) THANKS! and b) you may wish to use a text editor to 

store the key on a local file share that is accessible from every machine.  This will 

allow you to cut and paste the license key for all future installs.   
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5) Once you verify that the information is correct, click [Next].  You will then be prompted to 

verify your install choice: 

 

You should always use the LANSync Managed option if LANSync has been installed.  

The Stand Alone Install is for individual SI 5 users only that do not wish to share 

data and projects and do not use Business Manager.  If you wish to use Business 

Manager as a single user, you will still need to install LANSync. 
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6) You will now be prompted to choose the location of your LANSync server from the dropdown list 

that will contain a list of all of the machines (by machine name) on your network that have a 

SQL Server installed.  This will most typically be the machine where you ran the SI 5 Server 

Components install. 

 

7) Choose your LANSync Server location and then click [Next].  If you don’t see it in the list then 

you can type in the machine name or IP address. 

8) You will be prompted to click [Install SI 5] to complete your installation: 

 

9) Accept the License agreement and click [Next]. 

10) Decide where you want to place shortcuts. 
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11) Choose the install option.  “Typical” installs all components except LinkTools.  If you are sure 

this user will not need LinkTools then use “Typical”, otherwise choose “Complete”. 

 

12) Click [Install] 

13) When you see the following prompt, select [NO] if any of the following are true (There is no 

undo or “Back” for this step): 

a) You installed LANSync and copied the SI 4.6 SQL data to the SI 5 SQL database.  

You can say yes, but your local data will be overwritten later when you download 

data from the Server. 

b) You are a new SI 5 user and do not have a SI 4 MasterTable (database). 

c) You are a Beta user that would like to continue to use the data you created 

during the Beta process. 
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14) If no users have been created, see the chapter on SI 5 Administration.  You need a valid User 

name and that name needs to be assigned to a SI 5 license. 

 

15) The SI 5 Navigator will appear. 

 

16) Refer to the SI 5 User Guide for a complete description of this interface.
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Getting Started 
 

New Users 
Prior to beginning work with SI 5, we would suggest that you review the “Pre-implementation 

Guide” chapter in the SI 5 User Guide.  Once complete, run the Application Setup Wizard by 

clicking on the link as shown below. 

 

Next we would suggest that you explore the workings of MMPD, of particular interest will be 

Administration > LANSync tab.  This will determine how data is moved between your local 

machine and the Server.  Refer to the SI 5 User Guide for detailed instructions. 

Existing SI 4.6 Users (LANSync) 
As part of the installation process hopefully you copied your SI 4.6 SQL data to the SI 5 SQL 

Server database.  If so, the next step would be to download the server data to your local machine 

by going Launching MMPD from the SI 5 Navigator. 

   

Then click Administration > LANSync then [Copy Down To Local].  For a complete description 

of LANSync functionality, see the SI 5 User Guide. 
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SI 5 Beta User 
If you are a LANSync user and transferred your data to the SI 5 SQL Server, you will now need to 

download the database to each of your local machines.  Thanks again for your help with the SI 5 

Beta.  We look forward to your comments on the forum. 
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